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Slicer3

http://www,slicer.org

!faun'l

An end-user application for
Image analysis

An open-source environment
for software development

A software platform that is both
easy to use for clinical
researchers and easy to extend
for programmers
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Before Slicer3

# slicer opt

File View Help Modules

Data

Alignments

L
Add Add
Volume Nodel
Add Transform|  Add Msuixl

MRML File Contents [Current Scene}:

e el T w7 s sl T
o] Axisl | 5= None | _or] Ssgittal | Bg| Mone | _or| Corenal | Ba| None 1
| hone: | Fa| | | Hone | Fa| None |

fatration...

TOSOIITg TTOOTT KO IC IS IO S AL LI AT . . .
Loading Module wtkSubVolume. ..

Loading Module wvtkIeem.. |

Loading Mcdule vtkTenscrUtil...

Loading Medule vtkTransformVolume. ..
Loading Mcdule vtkVolumeTextureMapping...

Launching Slicer 2. opt.

Warning: updating year in copyright text to 2008 frem 2007

MainBoot: Reading Options.xml

Ready

{slicer 49 % -
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 Slicer 2.7-opt
Fie View Help Modules

EMAtlasBrainClassifier

1. 5elect Input Channels:

T: None I
T2 MNone

Align T2te T1?  On I O

2. Define Parameter Settings:

Generste 30 Models: | On _Off |
Working Directory: |c:xs|iner2.ws|ine.2.'. J
‘Bave Segmentation: m Off |

Start Segmentation

set f $fSeg.fStepl
DevAddLabel $f.[Title "1. Select Input Channels: " WTA
pack $f.ITitle -side top -padx $Gui(pad) -pady 1 -anchor w
frame $ffinput -bg $Gui(activeWorkspace)
pack $f.flnput -side top -padx 0 -pady O -anchor w
foreach frame "Left Right" {
frame $f.flnput.f$frame -bg $Gui(activeWorkspace)
pack $f.fInput.f$frame -side left -padx 0 -pady $Gui(pad) }
foreach LABEL "T1 T2" Input "SPGR T2W" {
DevAddLabel $f.flnput.fLeft.I$Input " ${LABEL}:"
pack $f.finput.fLeft.I$Input -side top -padx $Gui(pad) -pady 1 -anchor w
set menubutton  $f.finput.fRight. m${Input}Select
set menu $f.finput.fRight. m${Input}Select.m

eval {menubutton $menubutton -text [Volume($EMAtlasBrainClassifier(Volume,${Input}),node) GetName] -
elief raised -bd 2 -width 9 -menu $menu} $Gui(WMBA)

eval {menu $menu} $Gui(WMA)
TooltipAdd $menubutton "Select Volume defining ${Input}"
set EMAtlasBrainClassifier(mbSeg-${Input}Select) $menubutton
set EMAtlasBrainClassifier(mSeg-${Input}Select) $menu
# Have to update at UpdateMRML too
DevUpdateNodeSelectButton Volume EMAtlasBrainClassifier Seg-${Input}Select Volume,$Input
pack $menubutton -side top -padx $Gui(pad) -pady 1 -anchor w }
frame $f.fAlign -bg $Gui(activeWorkspace)
TooltipAdd $f.fAlign "If the input T1 and T2 are not aligned with each other set flag here"
pack $f.fAlign -side top -padx 0 -pady 2 -padx $Gui(pad) -anchor w
DevAddLabel $f.fAlign.IAlign "Align T2 to T1? "
pack $f.fAlign.lAlign -side left -padx $Gui(pad) -pady 1 -anchor w
foreach value "1 0" text "On Off" width "4 4" {
eval {radiobutton $f.fAlign.r$value -width $width -indicatoron 0\

-text "$text” value "$value” -variable EMAtlasBrainClassifier(Aligninput) } $Gui(WCA)
pack $f.fAlign.r$value -side left -padx 0 -pady 0 }
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3DSlicer

i slicer
Fle View Hep Modules

vore: Locator j
Add Add )
Volume’ Model ¥

Add Transtorm|  Add Matri|

MRML File Gontents (Current Scenel:

[/ 2o HER

nching Slicer 2
ning: updating

t

Reading Options.yml

r in copyright text to 20

From Slicer2 to Slicer3
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File Efit View Window Help Feedback

Sk

* Wekoame & About

sbshicer Welcome

30 Sliceris afree open source sofiwere plaform far medical image processing
an ofimage data. This modue contains some basic infomation
end uselul inks to gef you started Lsin Please see our website
o slicer.org 2nd fhe documentation on our wikifor mare information:
o slcer orlicerWikiTndex ohpiDocumentation 3.5

sk

‘Bint: to apen any information panel below, cic on s arey flle bar

Don'tshow s modle on sarha.
~ Ovemien
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3DSlicer

The New Execution Model

File Edit  wiew  Window

Help Feedback

(] (Bl woer | v — | [4] [5][

@ 3DSlicer
v

Help & Acknowledgement

-

-

Python HelloFPython

-

Input'Cutput

Parameter set =
—_— =

Status Completed with errors

Input Wolume —_—
output Walume ="

.

3

“* Hello Python Parameters

Cimensionality [3 ﬂ|

Default

Cancel | | Apply |
“* Manipulate Slice Wiews
| EE (@]
“* Manipulate 30 Wiew
e F=] s
et = O
LA

<category> Demonstration </category>

<title> Python HelloPython </title>

<description> Slicer Developer Course </description>
<version> 1.0 </version>

<documentation-url> </documentation-url>
<license></license>

<contributor>

Sonia Pujol, Ph.D., Surgical Planning Laboratory, Harvard Medical School
/contributor>

<acknowledgements> National Alliance for Medical Image Computing (NAMIC), Grant
54 EB005149. </acknowledgements>

parameters>

<label>Input/Output</label>
<description>Input/output parameters</description>
<image>
<name>helloPython</name>
<label>Input Volume</label>
<channel>input</channel>
<index>0</index>
<default>None</default>
<description>Input volume</description>
</image>

<image>
<name>helloPythonOutputVolume</name>
<label>Output Volume</label>
<channel>output</channel>
<index>1</index>
<default>None</default>
<description>Output filtered</description>

</image>

/parameters>
/executable>
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Slicer3 Execution Model

« This course is based on the Execution Model which
provides a mechanism for incorporating command
line programs as Slicer modules.

« Jim Miller, Dan Blezek, Bill Lorensen (GE)

« This course uses the Python interpreter that has

been integrated to Slicer.
python
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B o Pre-requisite

* This course supposes that you have taken the following
tutorial:

Slicer3 Data Loading and Visualization, Sonia Pujol

« The tutorial is available on the Slicer3.6 101 compendium:

© 2010, ARR
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B Material

This course requires the following material

 Slicer3-3.6.1 release version

« HelloPython.zip

Disclaimer

It is the responsibility of the user of 3DSlicer to comply with both the terms of the license
and with the applicable laws, regulations and rules.

© 2010, ARR
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HelloPython Course Material

Unzip the HelloPython.zip archive

2 HelloPythony -/Deskion/HelloPython) - gedit — B X
Fi

ile Edit View Search Tools Documents Help

BN e | & ¢ | & 4 #3

New Open Save ! Print... | Undo Redo | Cut Copy Paste | Find Replace

[ HelloPython.py 3¢ ‘
#1/usr/bin/env python

XML = """<?xml version="1.8" encoding="utf-8"?>
<executable>

rsion>1.0</version>

cense></license>
contributor> This module was developed by Sonia Pujol, Ph.D., Harvard University. </contributor>
slicer.org/slicerWiki/index.php/Slicer3.6:Training </documentation-url>

umentation-urls http://www.

nowledgements>
This work is part of the National Alliance for Medical Image Computing (MA-MIC), funded by the National
Institutes of Health through the NIH Roadmap for Medical Research, Grant U54 EBB@5149. </acknowledgements> -

<parameters>
abel>Input/Output</label>
<description>Input/output parameters</descr:
<image>
<name>helloPythonInputVolume</name>
<label>Input Volume</label>
nput</channel>

index=0</1index>
description>input volume</description>

~/

<image>

<name>helloPythonOutputVolume</nane>
<label>output Volume</label>

<channel>output</channel>
spgr.nhdr spgr.raw.gz i
[ ] [ L] <description>output volume</description>
</image>
=l

</parameters>
Ln 72, Col 15 INS

(124 SPGR images) HelloPython.py
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Overview

Part A: Integration of the HelloPython.py
program into Slicer3

Part B: Implementation of the Laplace operator
In the HelloPython module

Part C: Image Sharpening using the Laplace
operator

© 2010, ARR
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3DSlicer

3DSlicer

n
File Edit View Search Tools Documents Help
0 & . [ | & & & % [@@r
New Open Save | Print... | Undo Redo | Cut Copy Paste | Find Replace

[=] HelloPython.py ¢ |

#1/usr/bin/env python

n
XML = "“"<7xml version="1.0" encoding="utf-8"7> I I Ite I atl n I I e O I O I l
<executable>
<category=Demonstration </category>
<title=Python HelloPythons/titles

D

<description> Slicer developer course in Python
</description>

<version>1.

</version>

<license>=/license>

. I l S I . I 3
<contributor> This module was developed by Sonia Pujol, Ph.D., Harvard University. </contributor> I tO I C e
<documentation-url> http://www.slicer.org/slicerWiki/index.php/Slicer3.6:Training </documentation-url>
<acknowledgements>
This work is part of the National Alliance for Medical Image Computing (NA-MIC), funded by the National

Institutes of Health through the NIH Roadmap for Medical Research, Grant US4 EB085149. </acknowledgementss
<parameters>
<label>Input/Output</label>
<description=Input/output parameters</descriptions
<image>
<name>helloPythonInputVolume</name>
<label>Input Volume</label>
<channel>input</channel>
<index=0</index>

<description>input volume</description>
</image>
<image>
<name=helloPythonOutputVolume</nane>
<label>output Volume</label>
<channel>output</channel>
<index=1</index>
<descri
</image>
</parameters>

tion>output volume</descriptions

Ln 72, Col 15 INS
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Python Console

- 30 Slicer Version 3.6

Fils  Edit Feadback

Mod e

:@ IDSlicer

| |
Select Window—>Python Interactor to

3DSlice

==:|aunch the Python console of Slicer

- alcome & Aboul

vill

3D Slicerizafres opan source softwa e platiorm for medical image processing and 20
visualization of imags dats. This module contgins some bazic information and usaful links
o get you stared using Slicer. Plegse sea our webeite hiipofaea.2licer.org and the
documentation on our wiki for more information:

htto:ffaeees slicer orafelicaruikifinds:. choDocumentation-2.6.

3D Slicer is disribuied under a BED-style licenss; for detils about the confribution and
software licenzs agreament, plegss aee

htipeffnen.slic er.orgfog i-binfLicensad Slicarl icenssForm.pl. The softears ha: bean designed
for reesarch purpoess only and has nol bean reviewesd or approved by the Food and Drug
Adminiziration. or by anv cther agency.

Hint: 1o opsn any information pansl bslow, click on it grey ille bar.

Don' ehowe thiz modula on sarup.

“ Manipulatk Slice Wisws

(=2 & (3

“* Manipulak 30 View

Maone RAS: (87.3, 1.0, -125.0),
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3DSlicer

Python Console

-

Python Console v14
Python 2. 6.4+ (releaseZ6-maint:TEE51, Jun 4 2010, 11:39:23)
[GCC 3.4.6 20060404 (Red Hat 3.4 6-10)]

Copyright (c) Z2001-2009 Python Software Foundation.
A1l Rights Reserwved.

Copyright (c) 2000 BelOpen. com.
411 Rights Reserwved.

Copyright (c) 1995-2001 Corporation for Wational Research Initiatives.
411 Rights Reserwved

Copyright {c) 1991-1995 Stichting Mathematisch Centrum, Amsterdam.
Al]l Rights Reserwved.

Python Console wl. 4 by Ka-Ping Tee <ping@lfw. org:

333

Slicer’s Python console

Active Volume: =

¥ Display

£

¥ Info

< Manipulae Slice Wiews

(=] flt (2 @]

“ Manipulake 30 View

Pyihon Imeracior
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Python Console
P ————— Select File=>Add Volume

[Ba]| woose | sormone (][] B (] A (] (D] (S o [ [ o) ()| (O] ()| b | o 7 %2

!‘9 IDSlicer ’

- alcome & Aboul

3pslicer Welcome

vill

3D Slicerizafres opan source softwa e platiorm for medical image processing and 20
visualization of imags dats. This module contgins some bazic information and usaful links
o get you stared using Slicer. Plegse sea our webeite hiipofaea.2licer.org and the
documentation on our wiki for more information:

htto:ffaeees slicer orafelicaruikifinds:. choDocumentation-2.6.

3D Slicer is disribuied under a BED-style licenss; for detils about the confribution and
software licenzs agreament, plegss aee

htipeffnen.slic er.orgfog i-binfLicensad Slicarl icenssForm.pl. The softears ha: bean designed
for reesarch purpoess only and has nol bean reviewesd or approved by the Food and Drug
Adminiziration. or by anv cther agency.

Hint: 1o opsn any information pansl bslow, click on it grey ille bar.

Don' ehowe thiz modula on sarup.

“ Manipulatk Slice Wisws

(=2 & (3

“* Manipulak 30 View

Maone RAS: (87.3, 1.0, -125.0),
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Python Console

Load the dataset spgr.nhdr

e | evmovormron | [4] [] (%] [ oo B (2] (2] : .
: located in the directory

] alala
™ Help & Acknowledgement j % 0GR :HelIOPyth On/

j o sw Y || HelloPyth
o) swZ
) swk4
) System
1 tmp
) User Guides And
B 5 Users
) Shared
B 3 stuartwallace
.autohahn
.cups
.fontconfiy
.subversion
.Trash
| ) Xcode
Default B ) Deskiop
1 ) 3IMinuteFor3.6
() ChangeTrackerStuff-3.E . =

N 1 HelloPvthon I\j | |‘\| =

™

* Python HelloPython

3KB SunJun 619: FF
3KB SundJun 611 = =

Sun Jun 6 10
Sun Jun 610:

bescrpton —vawe—— |

* InputOutput J

* Hello Pythan Parameters J

vooobo

{
:
?

Path: [{Usersistuartwallaceilesktop/HelloPython/spgr.nhdr
“olume Options

Centered lgnare File Orientation Label Map Single File Name: |apgr

{
Recent Volumes: | Browse to CWD Apply| | Cance'

“ Manipulate Slice Views

L&EH

Add Volume. 4
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CE Python Console

amm N/ 3D Slicer Version 3.6 RC3

File Edit Wiew Window Help Feedback

[Ba] ]| e | et [ D (BT[] e B ] ) () (@] (o 5 () () I (o) (][] | - - [
E sDSlicer ' R /I

[ o Run the following code In the
—— Python console

Input Yolume

“* Hello Python Parameters

Default Apply

from Slicer import slicer

volumel = slicer MRMLScene.GetNodeByID(“vtkMRMLScalarVolumeNode 17)
data = volumel.GetimageData(). ToArray()
print data

[

—

&l[=] [ 4

[
L
[

| A
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3DSlicer

Python Console

File Edit View Window Help Feedback

X/ 3D Slicer Version 3.6 RC3

; (A \| Python Console v1.4
|E||HHI‘IH 000l
Load orimpart a MRML scene, or
add data.
J [330..., 023
211 013
B11....013]]
"M oooo... 000
. moo....000]
A 121...,22¢2]
113..,121]
[673...,235]
563 ..., 234]]
af (oo, oo '
4 oo...,000]
[210...,100]
221.., 122
m40....013]
[pao0...,012])
e 22|
—_—
Dimensionality |3 ¥
Default Apply

“* Manipulate Slice Views

EEmLBELE

* Manipulate 30 View

=]

File

L 10

Slicer displays the values of the
spgr dataset
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HelloPython.py

] HelloPythonpy (~/Deskton/HelloPython) - gedit —&X

File Edit View Search Tools Documents Help

O 6. 2% ¢ ¥ 4 =

New Open Save ! Print.. ' Undo Redo ' Cut Copy Paste ' Find Replace

| HelloPython.py 3‘§|

#!/usr/bin/env python B
XML = “""<7xml version="1.8" encoding="utf-8"7>

<executable>

<category=Demonstration </category=

<title=Python HelloPython</title>

<description> Slicer developer course in Python
</description=

<yersion=1.0</version>

<license></license>
<contributor> This module was developed by Senia Pujol, Ph.D., Harvard University. </contributor>
<documentation-url> http://www.slicer.org/sliceriiki/index.php/Slicer3.6:Training </documentation-url>
<acknowledgements>
This work is part of the National Alliance for Medical Image Computing (NA-MIC), funded by the National
Institutes of Health through the NIH Roadmap for Medical Research, Grant U54 EBOG5149. </acknowledgements>

<parameters>
<label>Input/Output</label>
<description>Input/output parameters</description=

Open the file HelloPython.py
located in the directory HelloPython

<LduEL>0ULpul vuLule</ tdueL>
<channel>output</channel>
<index>1</index>
<description=output volume</description>
</1mage=
</parameters>

Ln 72, Col 15 INS
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HelloPython.py

@ MM + HelloPython.py
[ #t Auzrbindeny, puthon

[ ¥ML = "vretaml version="1.8" encoding="wtf-=g"?>
<executablel

<categoryDemonstration </categorys |
<titlesPython Hel loPython</title>
<description? Slicer developer course in Python

| </descriptiony
O u e <wersionyl.8< varsions

<licenser</licenser
{eontributor? This module was deweloped by Sonia Pujol, Ph.O., Harvard University. </conteibutors
<documentation—urly http: Awew.slicer.orgfslicerdikifindex.php/Slicer3.6iTraining </documentation—url:

= = |
+ <acknowledgements |
i Thi=s work is part of the MHational Alliance for Medical Image Computing {(HA-MIC}, funded by the Hational Institutes of

Health through the MIH Roadmop for Medical Research, Gront US4 EBBBS149. <facknowledgements:

<parametersk
<labels Input/Outputs/label >
<de=scription? lnput foutput parameters</descriptiony
<image’ |
<name >he | LoPy thon | nputio lume < Aame > |
{label>Input Yolume</label>
<ehannal > inputd fohanne Ly
<index @</ indess
{description®input wolumed/description
</image> |
<image>
<name >he | LoPy thonDutputyo Lume < fhame >

<label»output Volume</label>

<channel routput/channe >

Cindexrt {findexy

<descriptionroutput volume<d/description?

</image’
</paraneters;

cparameters:
<lobel*Hel lo Python Porameters</label >
<descriptionyParameters of the Python Hello Python module </ description:

<integer:
<riame>dimensiona ity hame:
<longflagrdimensional ity lonaflagy
{description:Dimensional ity of the Laplace operator < description:
{label:*0imensional i tydlabels>
<defaul t>3</defaul t> |
<eonstraintsy |
<mimi mum>2< min mums
<mas i mum 3 /maz i mum
<feonstraints?
</integery
</parameters>

{fexacutable:

Execute

Slicer = _import_{"Slicer")
slicer = Slicer.slicer
scene = slicer .MAMLScens

function

© 2010, ARR
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= 3DSlicer

Module Description

t!/usr/bin/env python

ML= "< 7xmlversion="
<executable>

.0"encoding="utf-8"7>

<category>Demonstration </category>
<title>Python HelloPython</title>

<description> Slicer developer course in Python </description>
<version>1.0</version>

<license></license>

<contributor>This module was developed by Sonia Pujol, Ph.D., Harvard University. </contributor>
<documentation-url> http://www.slicer.ora/slicerWiki/index.php/Slicer3.6:Training </documentation-url>
<acknowledgements>

Thiswork is part of the National Alliance for Medical Image Computing (NA-MIC),

funded by the National Institutes of Health through the NIH Roadmap for Medical Research,
Grant U54 EB005149.

</acknowledgements>
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Module Parameters

<parameters> I

<label>Input/Output</label> ‘

<description>Input/output parameters</description>

<image>
<name>HelloPythonInputveitme</name> .
<label>Input Volume</label> A f||e that

|nput <channel>input</channel> Specifieg
Volume <index>0</index> the image

<description>input volume</description>
</image>

<image>
<name>HelloPythonOutputVolume</name>
<label>Output Volume</label>
OUtpUt <channel>output</channel>
<index>1</index>
VOI ume <description>output volume</description>
</image>
</parameters>

© 2010, ARR


http://na-mic.org/
http://na-mic.org/
http://na-mic.org/

Execute Function

def Execute ():
Slicer = import__ ("Slicer")
slicer = Slicer.slicer

scene = slicer MRMLScene

return

© 2010, ARR
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Integrating HelloPython to Slicer3

N Vale x| 3N Slicer Version 3.6 RC3

S5 I Cise sssassClick on the View->Application
Settings in the main menu

Application Settings Fz2 v

9 3DSlicer

-

Help & Acknowledgement
“* Python HelloPython

Parameter set

Status Completed with errors

-

Inputoutput

Input vWolume

output Volume

“* Hello Python Parameters

Dimensionality |3 4

Detault Apply

12@

“ Manipulate Slice Views

FEECELER

* Manipulate 30 View

[E<] [}
: ]
| ()=l

Application Settings

[
=1
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3DSlicer

Integrating HelloPython to Slicer3

X! 3D Slicer Version 3.6 RC3

Select Module Settings from the
Application Settings GUI

File Edit View Window Help Feedback

Woares | e e E . [ —— @
4
@ 3DSlicer i

T Help & Acknowledgement

“* Python HelloPython

Parameter set = =
= Arn) I/ Application Settings
Status Completed with errors || [| o face Settings + [ Module Settings

—Drag & Drop Setiings
InputVolume < | || ||—Toolbar Settings

- —Print Settings Select Modules...
— Slicer Settings
— Font Settings

-
Inputroutput Load Modules

Load Command-Line Plugins
output Wolume

LAIL]

Home Maodule:

” —Module Settings
Hello Python Parameters |—Remote Data Handiing Settings Extensions Install Path: [[dsUsersistuartwallace/Slicer3stuartwallace
Dimensionality |3 ¥ ||| |—1A-FEMesh Settings Temporary Dirsctory: ((Q/Usersistuantwallacersliceristuariwallace
Default

Apply | |Directary

{Users/stuartwallace/Desktop/HelloPython

Mk

11

Rl I

& &

&) Click on the "Add a preset” button to add one or more new user
module paths. Atypical Module path ends with lib/Slicer3iModules,

* Manipulate Slice Views

whereas a Plugins/CLP path ends with lib/3licer3/Plugins.
4]

“ Manipulate 30 View

User defined colar file paths:

O

[
=]

Application Settings
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3DSlicer

nteg

rating HelloPython to Slicer3

File Edit View Window Help

o
@ 3DSlicer

Frin Hakeymen

T Help & Acknowledgement

“* Python HelloPython

* Input/Qutput

“* Hello Python Parameters

Feedhack

[v]

Parameter set

Status Completed with errors

Input Wolume

autput Valume

Dimensionality |3

Default

* Manipulate Slice Views

L

“ Manipulate 30 View

Application Settings

Apply

LAIL]

coanmeates

la¥ala)

(— Interface Settings

—Drag & Drop Setiings
—Toolbar Settings

|— Print Settings

— Slicer Settings

—Font Settings

—Module Settings

—Remote Data Handling Settings
' —I1A-FEMesh Settings

“

-Click on the ‘Add a preset’

button, and enter the path to

HelloPython.py

I/ Application Settings
Module Settings
Load Modules
Select Modules...
Load Command-Line Plugins
Home Madule:

Extensians Install Path:

Temporary Directory:

| | Directory

[:I.iUsers.istuanwzllzcefsllcsrﬁstuanwz\Izct

[:I.iUsers.istuanwzllzcefsllcsrﬁstuanwz\Izct

{Users/stuartwallace/Desktop/HelloPython

11

S
ik

k on the "Add a preset” button to edd one or more new user

module paths. Atypical Module path ends with lib/Slicer3iModules,
whereas a Plugins/CLP path ends with lib/3licer3/Plugins.

User defined colar file paths:

Mk

© 2010, ARR


http://na-mic.org/
http://na-mic.org/
http://na-mic.org/

Integrating HelloPython to Slicer3

The path to the HelloPython.py
—_— - ..executable is now set-up in Slicer3.

—Drag & Drop Settings
— Toolbar Settings

— Print Settings Select Modules. ..
— Slicer Settings
— Font Settings
— Module Settings
— Remote Data Handling Settings Extensions Install Path:
— lA-FEMesh Settings

Load Modules

Load Command-Line Plugins

Home Module:

[:l.fLIsers.fStuart\.-.raIIa-:e.l’SIiu:erSstuarhl.rallau:f

Temporary Directory: [[Asusersistuartwallace/Slicer3stuartwallace

| Jorecory ] i

fusersfstuartwallacesDesktop/Hello Py thon

Click on the "Add a preset" button to add one ormore new user
module paths. Atypical Module path ends with libkSlicera/Modules,
whereas a Plugins/CLP path ends with libfSlicer3/Plugins.

~l | ==
|
L

Uzer defined colar file paths:

Click on the Close to exit the
Application Settings window.
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=« |ntegrating HelloPython to Slicer3

e ——— Select File2>Exitand re- m=--~
- - mrEestart Slicer

IDSlicer

L=

- alcome & Aboul

3pslicer Welcome

3D Slicerizafres opan source softwa e platiorm for medical image processing and 20
visualization of imags dats. This module contgins some bazic information and usaful links
o get you stared using Slicer. Plegse sea our webeite hiipofaea.2licer.org and the
documentation on our wiki for more information:

htto:ffaeees slicer orafelicaruikifinds:. choDocumentation-2.6.

3D Slicer is disribuied under a BED-style licenss; for detils about the confribution and
software licenzs agreament, plegss aee

htipeffnen.slic er.orgfog i-binfLicensad Slicarl icenssForm.pl. The softears ha: bean designed
for reesarch purpoess only and has nol bean reviewesd or approved by the Food and Drug
Adminiziration. or by anv cther agency.

Hint: 1o opsn any information pansl bslow, click on it grey ille bar.

Don' ehowe thiz modula on sarup.

“ Manipulak Slice Wiews

= & (B LB

“* Manipulak 30 View

Maone RAS: (87.3, 1.0, -125.0),
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HelloPython module

Fila Edit Wiew Windo

m IDSlicer

“ Walcoma & About

3DSlicer

» - Select the category ‘Demonstration’, and
oo, ANE MOdAule ‘Python HelloPython' in the

wvigualization of image dats. This modula contgil
10 gl you stared uzing Slicer. Plegzs sea our we

documentation on our wiki for mare informaiion
hticedfeeanee.clicar.orafzlicariikifindes:. phoDocur o u es I I I el I l l

3D Slicer iz disiribuied under a BSDetyla il

softea ra licanzs agrsament, pleass ass Lp = (| e L= o = o
htipeftnene.slicar.orgfcgi-bindL icensed SlicarLicenseForm.pl. The softeans has besn designed = = = ==l
for neesarch purpoess only and has nol bsen reviswssd or approved by the Food and Orug
Adminizsiration. or by anv oiher agancy.
u} a L}

Hint: 3 open any information pansl below, click on it grey fils bar.

Don showe 1his moduleon sarup.
“ Manipulak Slice Views
“ Manipulak 30 View
A (=7
] - = D
R L
| A

Mone RAS: (27.3, 1.0, -125.0),
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HelloPython Module

[aTala) X/ 3D Slicer Version 3.6 RC3

File  Edit
& &
@ 3DSlicer

View

= @) [ [e) B & % - [

¥ Help & Acknowledgement ‘ ‘

S—— The program ‘HelloPython’ is

Status Completed with errors

_ now integrated into Slicer3

“ Python HellaPython

Input Valume
-
autput Volume = | ‘
-
* Hello Pythan Parameters
Cimensionality |3 M
Default Apply

ey
e e

* Manipulate Slice Views

GEEE

* Manipulate 30 View

spgr RAS: (1316, 2.5, 186.3), Bg: Slice notshown,
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3DSlicer

Part B:
Implementing the
Laplace* Operator

*named after Pierre-Simon, Marquis de Laplace (1749-1827)

Programming into Slicer3. Sonia Pujol, Ph.D., Harvard Medical School
National Alliance for Medical Inage Computing © 2010, ARR
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& Execute Function

def Execute kHeI loPythoninputVolume, HelloPythonOutputVolume): ‘

Add the I/O code

Slicer = __import__ ("Slicer")

slicer = Slicer.slicer

scene = slicer. MRMLScene

inputVolume = scene.GetNodeByID(HelloPythoninputVolume)
outputVolume = scene.GetNodeByID(HelloPythonOutputVolume)

return

© 2010, ARR


http://na-mic.org/
http://na-mic.org/
http://na-mic.org/

& Laplace Operator

def Execute (HelloPythonlnputVolume, HelloPythonOutputVolume):

Add the Laplace
Slicer = ___import__ ("Slicer") operator
slicer = Slicer.slicer
scene = slicer MRMLScene
inputVolume = scene.GetNodeByID(HelloPythoninputVolume)

utVolume)

laplacian = slicer.vtkimageLaplacian()
laplacian.Setinput(inputVolume.GetimageData())

return

© 2010, ARR
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Laplace Operator

<parameters>
<label>Input/Output</label>
<description>Input/output parameters</description>
<image>

<name>HelloPythonInputVolume</name> Add a new parameter
<label>InputVolume</label> group for the Laplace

<channel>input</channel>
<index>0</index> Operator
<description>input volume</description>

</image>

<image>
<name>HelloPythonOutputVolume</name>
<label>Output Volume</label>
<channel>output</channel>
<index>1</index>
<description>outputvolume</description>
</image>
</parameters>
<parameters>
<label>Hello Python Parameters</label>
<description> Parameters of the Python Hello Python module </description>
</parameters>

© 2010, ARR
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& Laplace Operator

<parameters>
<label>Hello Python Parameters</label>
<description>Parameters of the Python Hello Python module </description>
<integer>
<name>dimensionality</name>
<longflag>dimensionality</longflag>
<description>Dimensionality of the Laplace operator</description>
<label>Dimensionality</label>
<default>3</default>

<constraints>
<minimum>2</minimum> Add the I—aplace
<maximum>3</maximum> operator’s
</constraints> dimensionality
</integer>

</parameters>

© 2010, ARR
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Laplace Operator

I.d.eLE&euuL&(.tLelloErthonlnputVolume, HelloPythonOutputVolume,
[dimensionality=3): Set-up the corresponding

Slicer = __import__("Slicer") dimensionality parameter

slicer = Slicer.slicer in the Python code
scene = slicer. MRMLScene

InputVolume = scene.GetNodeByID(HelloPythoninputVolume)
outputVolume = scene.GetNodeByID(HelloPythonOutputVolume)
laplacian = slicer.vtkimageLaplacian()

lanlaci : | \

laplacian.SetDimensionality(dimensionality)

return
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Laplace Operator

def Execute (HelloPythonlnputVolume, HelloPythonOutputVolume,
dimensionality=3).
Slicer=__import__ ("Slicer")
slicer = Slicer.slicer

scene = slicer MRMLScene
iInputVolume = scene.GetNodeByID(HelloPythonlinputVolume)
outputVolume = scene.GetNodeBylID(HelloPythonOutputVolume)
laplacian = slicer.vtkimageLaplacian()
laplacian.Setlnput(inputVolume.GetimageData())

lanlacian SetDimensinnalitv(dimensinnalityv)
| 7 \ A 4

Add code to get the output
of the Laplace operator

laplacian.Update()
outputVolume.SetAndObservelmageData(laplacian.GetOutput())
return
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&~ Laplace Operator

def Execute (HelloPythonInputVolume, HelloPythonOutputVolume,
dimensionality=3):

Slicer = ___import__ ("Slicer")
slicer = Slicer.slicer

scene = slicer MRMLScene
iInputVolume = scene.GetNodeByID(HelloPythonlinputVolume)
outputVolume = scene.GetNodeByID(HelloPythonOutputVolume)
laplacian = slicer.vtkimageLaplacian()
laplacian.Setinput(inputVolume.GetimageData())
laplacian.SetDimensionality(dimensionality)

laplacian.Update()
outputVolume.SetAndObservelmageData(laplacian.GetOutput())
matrix = slicer.vtkMatrix4x4()
inputVolume.GetlJKToRASMatrix(matrix)
outputVolume.SetlJKToRASMatrix(matrix)

return

Place back the Laplacian
of the image in the RAS
reference system.
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&=+ Integrating HelloPython to Slicer3

def Execute (HelloPythonlnputVolume, HelloPythonOutputVolume,
dimensionality=3):

Slicer=__import__ ("Slicer")

slicer = Slicer.slicer

scene =slicerMRMLScene

inputVolume = scene.GetNodeByID(HelloPythonInputVolume)
outputVolume = scene.GetNodeByID(HelloPythonOutputVolume)
laplacian = slicer.vtkimageLaplacian()
laplacian.SetInput(inputVolume.GetimageData())
laplacian.SetDimensionality (dimensionality)

laplacian.Update()
outputVolume.SetAndObservelmageData(laplacian.GetOutput())
matrix = slicer.vtkMatrix4x4()
inputVolume.GetlJKToRASMatrix(matrix)
outputVolume.SetlJKToRASMatrix(matrix)

return

Save the HelloPython.py file and exit Slicer.
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~3DSlicer

Part C:
Image Sharpening with
the Laplace Operator

© 2010, ARR
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3DSlicer

nning the Laplace Operator

'Re-start Slicer and select
| ernere (| | E @

B e : File>Add Volume

¥ Help & Acknowledgement

[aXaNa)

“ Pythan HelloPython

Parameter set

Status Completed with errors

* InputiDutput

Input Yalume =
-
output Volume =
-
“ Hello Python Parameters
Dimensionality |3 M
Default Apply

* Manipulate Slice Views

I

* Manipulate 30 View

spgr RAS: (131.6, -2.8, 186.3), Bg: Blice notshown,
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= Running the Laplace Operator

Load the dataset spgr.nhdr

Modios: | Py HokEpn [R—— @
‘

B s » located Iin the directory

=4 — .

v
~ Help & Acknowledgement J % OS5 ag :H6||0Pyth On/

. HelloPython
“ Bython HelloPyth s
ython HelloPython J o swe HelloPython.pyc JKB SunJun 6193 =

) swbd D Py oM 3KB SunJun B11: |\] T
) System spgr.nhdr 1 KB SunJun 610

= tmp Spgr.rav.gz 6517 KB SunJun 610: |K
“ InputOutput J D 3ser Guides And Information
B ) Users
) Shared
= ) stuartwallace
.autohahn
.Cups
.fontconfig
.subversion
.Trash
Xcode
B [ Desktop
) 3Minute Ford.6
=) ChangeTrackerStuff-3.6 =
-\ Hello Pvthon i

<! E—— == ] 5 || e —

Path: |/Usersfstuartwallace/Desktop/HelloPythonfspgr.nhdr

* Hello Python Parameters J

g
0ooD0D00

Default q

s

£
|
P

Volume Options X

Centered Ignore File Orientation Label Map 3ingle File MName: |spgr

|
Recentvolumes: | _
* Manipulate 3lice Views Browse to CWD Apply Carn:e'/}

=@ G0

“ Manipulate 30 View

Add Volume...


http://na-mic.org/
http://na-mic.org/
http://na-mic.org/

. 3DSlicer

Running the Laplace Operator

AAA %/ 3D Slicer Version 3.6 RC3

File Edit View Windg Belo  Feedback

(AL ES o B NE e EE ] E & -

_ Browse to the Category
— ‘Demonstration’ in the Modules

Statuz Completed with errors

menu, and select the module

Inputioutput parameters

N ‘Python Hello Python’

Default Apply

!9 3DSlicer

“ Hello Python Parameters

-

A sagtta ; Hone 4 conna ;A Nens
i@ e o - o —
8 |23 128 |13.769

LA 3

Pt
129 |-27.932

* Manipulate Slice Yiews

EEIDEREERE

“ Manipulate 30 View

E% HEEP o

i=]

' e B8] O
A RIEIRIE

spar! RAS: (128.1,12.8, 37.2), Ba LIK: (128, 138, 145), Bg: Qut of Frame,
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£ < Running the Laplace Operator

NaYala) [\| 3D Slicer Version 3.6 RC3

— EE o BEEEBET & § -
B oo | N /|
s Select the input volume
: ‘spgr.nhdr’, select the output
p———— volume ‘Create New Volume’,

output Volume | o

: nd click Appl
“ Hello Python Parametars a C I C O n p p y
Dimensionality |3 » [V |
Default Apply -
" Hena
4 -5
HNena =1
-

c St ;. s - oans :Av Hens =
: tone =] = - e AE - .
8 [23 128 |13.769

* InputQutput

s
129 |-27.532

* Manipulate Slice Views

EEEONEEEEE B

* Manipulats 30 View

P @ (a]
et 2 IDI
L] =] ]k

spar RAS: (0.9, 183.3, 97.9), Bg LIK: (-53, -8, 1), Bg: Out of Frame,
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= Running the Laplace Operator

Slicer displays the Laplacian of the spgr image.

»
@ 30Slicer

¥ Help & Acknowledgement

* Python HelloPython

Farameter set — |
n |::1

Status Completed

Inputvolume | 5 ’:

Al
A
Al
A

OutputWolume | g & — ’:
“ Hello Python Parameters
‘ Dimensionality |3 ﬂ|
. T

Cultput velme = ‘l%

“ InputiOutput

Default Cancel Apply 7 . ] ]
] . [ comtme ] . ] . ] .
e ; 128 12789

120 |27.632

“ Manipulate Slice Views
EEENENEERE

“* Manipulate 30 View
v |HEE R ®

L agmE s O
L

Quiput Volume RAS: (0.8, 135.6, 83.8), Ba 1K (-7, 9. 61), Ba: Qut of Frame,

L9y
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Laplacian of the image

—— Select the module Volumes from the main menu

13
@ 30Slicer

7 Help & Acknowledgement

* Python HelloPython

Parameter set —
" |::1

Status Completed

Inputvolume | 5r ’:

Al
Al
Al
Al

OutputVolume | o 5 — ’:
* Hello Python Parameters

‘ Dimensionality [3 j|
. e |
=3

Default ’m ’W
-
- L} 2 Ll L Cutput Womes
S ; - 128 13763

“ InputCutput

“ Manipulate Slice Views
EEpLDEEEEE R [E]

“* Manipulate 30 View

o ElEEERoe
[P e ]

9y

Qutput Volume RAS: (0.6, 138.6, §3.8), Bg lJK: (-7, 8. 611, Ba: Out of Frame,
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Laplacian of the image

:Set the Active Volume to Output Volume and adjust the
‘Window/Level parameters

Active Villime: Cutput Volume

“ Display

Laokup Table: Grey =

Interpolate

Wyinciowy Lewel Editor Presets:

Threshold:

4
¥

Update Histogram Interactively

s e — = =] s — [ |2 =] comnal o ==
(875, B54] % [0,1] i Howe crprtuoime == Nowe — orprtuomme |z Nowe o iprtuoime ==
=]+ Kl

129 |-27.532 . 126 |13.759

“ Manipulate Slice Yiews

EEELEN

“ Manipulste 3D Yiew
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B Image Sharpening

Run the following code in the Python s
console to subtract the Laplacian of the
|mage to the original image —

\\\\\\\
oooooooooooo
mmmmmmmmm ‘

import Slicer
volumel = Slicer.slicer MRMLScene.GetNodeByID(“vtkMRMLScalarVolumeNodel”)

volume2 = Slicer.slicer MRMLScene.GetNodeByID(“vtkMRMLScalarVolumeNode2”)

plugin = Slicer.Plugin(“Subtract Images”)
plugin.Execute(volumel,volume?2)

— — =— — - 5 .

‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘ oSN g X 7 -\'\\
...D.... =1 @] £ RS i3 ' Ll
bR SN e A I R
2 S it Crat 3

jj==m N : Yol e o

(1] ) i SN ESE R N

* | [zl Vo

\ [ @
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3DSlicer

Image Sharpening

—18] ]

2 3D Slicer ¥ersion 3.6.1
File Edit Wew Window Help Feedback

. Modiks: Dat — Elz‘,i@
'{.b) 3DSlicer .

Select the module Data

¥ Help & Acknowledoement

|

“ Display & Madity Scene

- The subtracted image

Wigw

X

Default Scene Camera

—vtkMRML ScalarVolumeNodeA
st £ appears Iin the data tree

Dizplay MRML ID's

MRML Mode Inspector

[
N

* Load & Add Scenes Or Individusl Datasets — ~ = -
Bt skl e — 5 nowe s ® cornal Nowe ==
Lo ness sene (slose currert) Hore O rpatioinme — = Cvptiaime —|= Hoie Orpatiolime — |z
&dd & =cene (to current) @D |V” 4 |
\ 129 [-27532 128 [13763
Add data or & data directory

’ﬁ‘ ’E Aoddd scalar and tensor volumes: ﬂ

Manipulste Slice Views

BB

Manipulste 30 Yiew

-

-
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3DSlicer

Image Sharpening

= = MLEEF - Bl B k-
| Click on the links |&|and on the eye |~
icon to display the subtracted image
vtkMRMLScalarVolumeNodeA in the
e .| viewer

“* Load & Add Scenes Or Individual Datassts £ f—
ai al Iy
Howe — Syt == Hare — e Comual Hate ==
Load new scene (close current) AMRMLIAEr e Hodk s 1 Howe — = PR M LScaknane ok, —1 | = Howe MRMLScakIone Noks, 1 | =
Addascene(tocurrent) @‘V” hd | @'VH hd |
120 [2rsa | 63 |23 [ | 128 13769

Add dsts or 5 data directory

EI @‘_ Add zcalar and tensor volumes

* Manipulste Slice Yiews

ElE L@ E

* Manipulste 30 View

ot | BE
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Image Sharpening

-
)
9]
%2}
(@]
M

Laplacian filtered

Laplacian

original
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& Conclusion

« This course demonstrates how to integrate an external
program in Python within Slicer3

« The Execution Model of Slicer3 provides a simple

mechanism for incorporating command line programs as
Slicer modules in Python.

= @ python’

iDSlicer
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